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iPower System Software 
Release Bulletin and 

Installation Instructions 
Version 5.3.0 

This Polycom® iPower™ multimedia conferencing system software release 
bulletin provides information about software Version 5.0.0. This document 
includes the following topics: 

§ Product Description 

§ Maintenance Update 5.3.0 

§ Enhancements in This Release 

§ Compatible Communications Products 

§ Restrictions and Recommendations 

§ Additional Information 

§ Installing Version 5.0 Software on the iPower Systems  

§ Installing Maintenance Update 5.2.0 on the iPower Systems  

Product Description 
The iPower system is a state-of-the-art multimedia conferencing system 
incorporating the Polycom iPower architecture. This architecture offers 
unique capabilities that simplify the inclusion of information in a meeting and 
make it easier to manage both the system and the network it runs on. The 
iPower system performs as a multi-purpose conferencing system that can 
be used both on and off a call. For more information, go to 
www.polycom.com. 

Maintenance Update 5.3.0 
If you are currently using version 5.0.0, 5.1.0 or 5.2.0 software, Polycom 
recommends that you install update 5.3.0. This maintenance update contains 
the following improvements: 
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• Improved interoperability with VSX 7000. 

• Improved robustness on startup.  Previously, the UI would sometimes fail 
to launch on startup or would display black video in the main window. 

• Support for configuring NAT on systems running languages other than -
English.  Previously, one could configure a NAT address on one of these 
systems but could not remove it. 

• Improved interoperability in H.323 calls with TeamStation. 

• Improved interoperability with Vtel Galaxy v2.1. (Note: iPower already 
worked with Galaxy v2.2) 

• Improved robustness in ISDN calls.  Previously, the system could 
experience an internal system error if it received but did not answer two 
incoming calls in rapid succession. 

• Improved VCR recording/playback of Content in calls with systems that 
do not support People and Content.  Under some circumstances, iPower 
would send an image too large for the far end system’s display, with the 
result that would get cropped. 

• iPower can send send events to a Global Management System running in 
a Windows 2003 Server environment. Previously, iPower support GMS 
running on other operating systems (such as Windows 2000) but not 
Windows 2003 Server.  

• Improved robustness in V.35/RS449 calls.  Previously, the system would 
sometimes not recover from a failed call. 

• Improvements to the iPower Control Protocol.  See iPower Control 
Protocol Programmer’s Guide for details. 

5.3.0 also includes the enhancements that were previously provided in software 
version 5.2.0: 

§ Improved stability of VGA sources in iPower 9000 systems.  

§ Improved reliability when logging off the system.  

§ Support for using an aux camera as a People source while in a call.  

5.2.0 also includes the enhancements that were previously provided in software 
version 5.1.0: 

§ Improved interoperability with other Polycom products, especially 
Polycom EX/FX v5.x, Polycom MGC v5.x and Polycom ViaVideo v5.x.  

§ Support for the Global Address Book in Global Management System 
version 5.1.  

§ Support for ViaVideo version 2.2 endpoints in multipoint calls hosted on 
an iPower system.  

§ Improved reliability in gateway calls.  
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§ Automatic microphone muting when sending DTMF tones: This provides 
cleaner input to systems (such as gateways) that use DTMF.  

§ Improved robustness of H.320 calls when network errors occur.  

§ Support for viewing Content locally in a voice-only call  

§ Improved support for editing a recorded conference.  

§ Support for streaming the Windows desktop outside of a call.  

§ Resolution for an intermittent problem where UI elements (such as the 
Make a Call button) on iPower 900 systems could become corrupted with 
purple or pink lines. While this problem did not disrupt the operation of 
the system, it was distracting and unsightly.  

§ Reliable local video display on startup. Previously, the system would 
occasionally display black video on startup. Switching to the full screen 
view and back restored normal video.  

§ Additional call status information for iPower Control Protocol clients. 

Enhancements in This Release 
Version 5.0 enhancements include better video quality, tighter integration of 
video and collaboration, and expanded features, including People+Content™ 
Streaming and optional Digital Conference Recording. This release also offers 
the industry’s first videoconferencing and Web collaboration integration. 
Enhancements include: 

§ People+Content Streaming and Digital Conference Recording 

§ Expanded integration with the Web 

§ Calling enhancements 

§ IP network enhancement 

§ Additional system controls for users 

§ Enhanced user interface 

§ Administrator customization options 

§ Hardware enhancements 

§ Enhanced system management 

People+Content Streaming and Digital Conference 
Recording 

§ All iPower systems now support streaming the entire conference, 
including People video, People audio, and Content. Remote users can see 
and hear the conference using any standard web browser. Administrators 
can configure the system to offer the stream directly from the iPower 
system or use an external streaming server to deliver the stream.  

§ Digital Conference Recording (Optional) lets you record any conference 
on the iPower system and store it on the iPower system itself or on 
external storage media. No additional software is required. 
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§ Calls made through the Polycom MGC-25, Polycom MGC-50, and Polycom 
MGC-100 multipoint servers can now include People+Content, Siren 14 
audio, and Pro-Motion video. 

Expanded Integration with the Web 
§ The integrated WebOffice client and administrator-configurable server 

functions allow iPower users to share Content with all participating sites, 
whether they use video systems or web browsers to access the 
conference. 

§ Users can now dial from the iPower system with a single click on a web 
page link. Clicking the “CallTo” HTML hot spot initiates a call at the 
default rate for which the iPower system is configured. 

Calling Enhancements 
§ iPower 9000 systems now support the H.264* video algorithm for sharper 

People video at half of the bandwidth requirement. This algorithm is the 
default for all H.320 and H.323 calls at 512 kbps or lower. Calls above 
512 kbps use Pro-Motion™ interlaced video. Both H.264* and Pro-Motion 
video are also supported by the MGC version 5.0. 

§ The iPower 600 system now supports data rates up to 2 Mbps. The 
iPower 600 system can also transmit and receive Pro-Motion interlaced 
video.  

§ A set of Polycom video test numbers is now pre-loaded in the Local 
Directory of all new systems.  

§ Internal Multipoint includes several enhancements: 
– 12-site multipoint option is now supported on all iPower systems. 

– Internal Multipoint calls support full People+Content and Dual Images  

– Pro-Motion is supported for all iPower sites in the call 

– Users can now store information about multiple sites as a single entry 
in the Directory.  

– Users can choose multiple sites from the Directory using a point and 
click interface. 

§ iPower systems now support Conference on Demand with H.320/ISDN 
connection to MGC using PathNavigator v5.0. 

§ H.320 calls include these enhancements: 
– H.243 Chair control functions, including allowing the Chair controller 

to choose the broadcaster, allowing users to request the floor, and 
browsing capability. 

– SureConnect™ Downspeeding on the first B-channel of the first BRI 
line 

IP Network Enhancements 
§ Network Address Translation (NAT) is now supported on iPower systems 

for calling behind a firewall. The system supports both auto-discovery 
and manual assignment. 
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§ This version includes the following additional IP/H.323 network 
enhancements: 
– Automatic Gatekeeper discovery 

– Configurable TCP/UDP port ranges 

– Configurable IP QoS settings (IP Precedence, DiffServ, RSVP) 

– Asymmetric call support for ADSL connectivity 

– Lockable LAN/H.323 network settings  

– The iPower system now allows the Administrator to check for updated 
iPower software with a single click in AdminTools.  

§ The iPower system now supports secured calls via Virtual Private Network 
(VPN) with standard third party VPN software clients.  

§ iPower systems support dual IP connectivity for environments configured 
to route video calls over a specified video network and data/web traffic 
over a separate network. Note that an additional NIC is required for this 
enhancement. 

Additional System Controls for Users 
§ Users can now set preferences that let them:  

– Specify whether the system should answer calls automatically 

– Choose a default dialing directory 

– Change the PIP position for the second monitor 

– Choose whether to hide the cursor after a specified time  

§ Users can specify a time during which the system refuses incoming calls 
(“Do Not Disturb” mode). 

§ Users can access Conference Statistics, Operating Statistics, and 
System Information directly from the Options menu. In addition, statistics 
are now available for Dual Images and Multipoint calls. 

Enhanced User Interface 
§ The Options Menu has been updated for more efficient access to 

conferencing tasks. 

§ The user interface includes new icons for communicating system status: 
– People+Content Streaming icons 

– Digital Conference Recording icons 

§ The iPower 600 and 900 systems now include these new on-screen 
icons:  

– Keyboard status indicators in the System Tray 

– Full-screen button  

– Mute and automatic camera pointing status indicators 

– Local or Far end control indicator 
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Administrator Customization Options 
§ AdminTools automatically coordinates shutdown of the iPower 

collaboration application. Administrators no longer need to shut down the 
iPower application before starting AdminTools. 

§ Administrators can add a custom logo to the main collaboration window. 
To do this: 

1. Make sure your graphic is 140x30 pixels in size.  

2. Rename it “custom.bmp”. 

3. Save it in C:\Program Files\Picturetel\VCS.  

§ Administrators can add up to four application shortcuts to the Options 
menu, including WebOffice, File Transfer, and any two other applications. 
See AdminTools help for information about configuring this option. 

§ Administrators can add up to four additional shortcuts to the People and 
Content list, including Whiteboard, Chat, and any two other applications. 
See AdminTools help for information about configuring this option. 

§ The iPower system’s home web page can now be customized to include a 
custom graphic, information about the location of the system, and other 
information for users accessing the system from a web browser. See 
AdminTools help for information about configuring this option. 

Hardware enhancements 
§ The iPower 600 and 900 systems now support the new wireless keyboard 

and remote control. For more information about using the new keyboard 
and remote, see the iPower Collaboration System Quick Tips Sheet, 
available on the iPower Documentation Library CD. 

§ The iPower 9000 systems now support use of the iPower 80 camera. 

Enhanced System Management 
§ The iPower system now supports these Global Management System 

version 5.0 features: 
– The iPower system can register with the Global Directory. Users can 

browse the Global Directory. 

– The administrator can configure (provision) multiple iPower systems. 

– The administrator can update iPower system software as a scheduled 
task or as an as-needed task. 

– The iPower systems can send Readiness messages to the 
administrator. 

§ WebRemote supports SSL secure connections.  

§ A user logged into an account with User privileges can now operate the 
iPower system. 
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Compatible Communications Products 
The iPower multlimedia conferencing system is tested extensively with a 
wide range of products. The following list is not a complete inventory of 
compatible equipment; it simply indicates the products that have been 
tested for compatibility with this release. 

Note: Visual collaboration systems use a variety of algorithms to 
compress audio and video. In a call between two systems, each 
end transmits audio and video using algorithms supported by the 
other end. In some cases, a system may transmit a different 
algorithm than it receives. This process occurs because each 
system independently selects the algorithms it considers best for a 
particular call. At times, different products make different (though 
reasonable) choices. This process should not affect the quality of 
the call. 

Compatible Conferencing Equipment 
§ Avaya™ (Lucent™) MCU Version 7.0 

– Calls placed with an Avaya MCU do not support T.120.  

– Conferences hosted by an Avaya MCU do not support the Browse 
function. (PRDbg17986)  

§ Cisco® Multimedia Conference Manager Version 12.2 
Multimedia Conference Manager includes the MCM Gatekeeper. 

– The MCM proxy feature of the Multimedia Conference Manager blocks 
several iPower capabilities including Dual Images, G.722.1, and 
Siren™ 14 audio. Polycom recommends that you disable the MCM 
proxy feature if you use it only to provide Quality of Service (QoS). 
Note that the iPower RSVP feature provides QoS functionality for 
iPower systems. 

§ Intel TeamStation™ Version 5.0a 

§ iPower 600 and 900 Collaboration System Versions 3.1.0 and 4.0.8 

§ iPower 900 Collaboration System Version 2.0.5 

§ iPower 9000 Collaboration System Version 4.2.5 

§ Microsoft NetMeeting Version 3.01 
– Under most circumstances, the system will negotiate to QCIF for calls 

to NetMeeting systems. 

§ Polycom PathNavigator Versions 1.10 and 5.0 

§ Polycom MGC-25™ version 5.5 

§ Polycom MGC-50™ and MGC-100™ Multipoint Conferencing Unit (MCU) 
Versions 4.6 and 5.0 
– The Polycom Version 4.0 MGC-50 and MGC-100 MCUs do not support 

far-end camera control or browsing.  

– DO NOT attempt to run versions of the Polycom MGC-100 MCU lower 
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than 2.2 with iPower Multimedia conferencing systems. 

– You may experience poor quality when sending Content in a LAN call 
using a Polycom MGC-50 or MGC-100 MCU running Version 4.00 or 
lower. To address this issue, use version 4.01 of the Polycom MGC-50 
or MGC-100 MCU. 

– You may experience problems with application sharing in a conference 
using a Polycom MGC-50 or MGC-100 MCU running Version 4.00 or 
lower. To address this issue, use version 4.01 of the Polycom MGC-50 
or MGC-100 MCU. 

– iPower's Far End Camera camera does not work with MGC's Dynamic 
FECC.  Configure FECC statically instead. 

– When you use iPower Control Protocol to make calls from a LAN 
system to an ISDN system:  

o All prefixes and suffixes required by the gateway must be 
configured through AdminTools 

o The iCP Command must set the Calltype to Gateway 

§ Polycom ViaVideo™ Versions 3.0 and 5.0  

§ Polycom ViewStation 512 Version 7.2 

§ Polycom ViewStation 4000/FX Versions 4.2 and 5.0 

§ Polycom ViewStation EX Version 5.0 

§ Polycom ViewStation MP Version 7.2 

§ RADVISION ViaIP ECS Gatekeeper Version 2.0 

§ RADVISION BRI/PRI Gatekeeper NGK 100/200 Revision 2.0 
– RADVISION gatekeepers configured for H.245 gatekeeper-routed 

signaling do not support calls from iPower systems. The gatekeeper 
must be configured for direct signaling or for gatekeeper-routed 
Q.931 signaling.  

§ RADVISION BRI/PRI On-LAN L2W-323 Gateway Revision 2.2 
– Calls through a RADVISION gateway at 2x64 kbps must include an 

asterisk (*) suffix to the number dialed. Without this suffix, the call 
connects to the far end at 1x64 kbps. 

§ Tandberg 6000 Versions B4.3 and 6.1 

Internal Multipoint Option Compatible Products 

Internal Multipoint compatibility has been tested and found to be 
interoperable with the following products:  

§ iPower 600 and 900 Collaboration Systems Versions 3.1 and 4.0.0 

§ iPower 9000 Collaboration System Version 4.2.0 

§ Polycom PathNavigator Versions 1.10 and 5.0 

§ Polycom ViaVideo™ Version 3.0 and 5.0 

§ Polycom ViewStation 512 Version 7.2 

§ Polycom ViewStation 4000/FX Versions 4.2 and 5.0 
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§ Polycom ViewStation EX Version 5.0 

§ Polycom ViewStation MP Version 7.2 

§ RADVISION ViaIP ECS Gatekeeper Version 2.0 

§ RADVISION BRI/PRI Gatekeeper 

Compatible Network Interface Equipment 

This section contains information on terminal adapter compatibility. The 
following products are compatible with this release of the iPower multimedia 
conferencing system:  

§ Lucent/Ascend VSX Version +4.5Cp15+ 

§ Promptus/DICA Hotlink Version 1.50V4 

§ Madge 20™ Version 5.20.1.17 

Restrictions and Recommendations 

This section lists the current restrictions in the following areas: 

§ General 

§ Security 

§ Global Management System 

§ PathNavigator Call Processing Server 

§ Software Configuration 

§ Logging On and Logging Off 

§ Audio 

§ Video 

§ VCR 

§ Calling 

§ Internal Multipoint Option 

§ WebRemote 

§ Hardware 

§ iPower Applications 

§ Third-Party Applications 

§ Localization 

§ Data Collaboration 

General 
§ iPower cannot receive a snapshot (still image graphic) in a call that 

supports People and Content. 
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§ The iPower 9000 system does not support Windows Standby mode, even 
though it is listed as an option in the Windows Shutdown menu.  

§ Use the Shutdown menu to power off the iPower 9000 system. Do not 
press the front panel power button to perform a shutdown.   

§ In order to upgrade the system, you must be logged in with the account 
“Administrator”. The upgrade will fail if you log in with any other account, 
even if it has administrator privileges.  

§ If you set a password for accessing a streamed conference and then 
click the Set button to view or alter conference settings, the password 
is deleted. Users can then access the stream without supplying a 
password. To avoid this, be sure to reset the password after you open 
the Stream to Web dialog box.  

§ Names for streamed conferences cannot include special characters other 
than @, ! or _ (underscore). If you use special characters in a streamed 
conference’s name, remote users who use a web browser to view the 
conference see the embedded media player with no video.  

§ Recorded streams can quickly take up large amounts of hard disk space. 
When you record streams to the system’s C drive, monitor the available 
hard disk space to ensure that the system has adequate free disk space 
for proper operation.  

§ If you change the screen resolution while the iPower application is 
running, the system experiences a “blue screen” crash.  

Security 
§ Starting in version 5.0, only Integrated Windows Authentication is 

enabled on the WebRemote web server by default. Basic Authentication 
is not enabled in the default configuration. Note that this is a change 
from previous software versions, which enabled both Basic Authentication 
and Integrated Authentication security levels by default. 

Using Windows Integrated Windows Authentication provides greater 
security than Basic Authentication, but it prevents browsers other than 
Internet Explorer from using WebRemote.  Using Integrated Windows 
Authentication may prevent logging into WebRemote if the network does 
not provide appropriate support.  For more information on configuring 
WebRemote's security options, see Configuring Web Remote Security, 
available in the Security Center at www.polycom.com.  

§ You should ensure the security of your system by taking the following 
precautions: 
– Make sure that all accounts use effective passwords, especially those 

with administrative privileges. 

– Install, update, and use anti-virus software. 

– Install the latest security updates for Windows and for any 
applications you install.  

– Activate auditing for Windows events and monitor the audit log. 

– Restrict anonymous logins. 

– Conduct periodic reviews of your system. The Microsoft Baseline 
Security Analyzer (available free at 
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http://www.microsoft.com/technet/ security/tools/tools.asp) can aid 
you in this review. 

– Check with your network administrator for security procedures. 

§ Based on the Windows features used by the iPower software, Polycom 
strongly recommends that you install the following service packs  

– Windows 2000 Professional Service Pack 3 

– Internet Explorer 6 Service Pack 1 or Internet Explorer 5.5 Service 
Pack 2 

§ In addition, Polycom strongly recommends that you install the following 
security patches: 

   Factory-installed on these 
systems: 

This bulletin: Available at: Fixes this problem: 4.0.0 4.2.0 5.0.0 5.2.0 

MS01-029  http://www.microsoft.com/technet/ 
security/bulletin/MS01-029.asp 

Windows Media Player .ASX 
Processor Contains Unchecked 
Buffer 

Yes  Yes  Yes  Yes  

MS02-008 http://www.microsoft.com/technet/ 
security/bulletin/MS02-008.asp 

XMLHTTP Control Can Allow Access  
to Local Files  

No Yes  Yes  Yes  

MS02-032 http://www.microsoft.com/technet/ 
security/bulletin/MS02-032.asp 

26 June 2002 Cumulative Patch for 
Windows Media Player (Q320920) 

No Yes  Yes  Yes  

MS02-042 http://www.microsoft.com/technet/
security/bulletin/MS02-042.asp 

Flaw in Network Connection Manager 
Could Enable Privilege Elevation 
(Q326886) 

No Y es  Yes  Yes  

MS02-045 http://www.microsoft.com/technet/ 
security/bulletin/MS02-045.asp 

Unchecked Buffer in Network Share 
Provider Can Lead to Denial of 
Service (Q326830) 

No Yes  Yes  Yes  

MS02-048 http://www.microsoft.com/technet/ 
security/bulletin/MS02-048.asp 

Flaw in Certificate Enrollment Control 
Could Allow Deletion of Digital 
Certificates (Q323172) 

No Yes  Yes  Yes  

MS02-050 http://www.microsoft.com/technet/ 
security/bulletin/MS02-050.asp 

Certificate Validation Flaw Could 
Enable Identity Spoofing (Q328145) 

No Yes  Yes  Yes  

MS02-055 http://www.microsoft.com/technet/ 
security/bulletin/ MS02-055.asp 

Unchecked Buffer in Windows Help 
Facility Could Enable Code Execution 
(Q323255) 

No No Yes  Yes  

MS02-062 http://www.microsoft.com/technet/ 
security/bulletin/ MS02-062.asp 

Cumulative Patch for Internet 
Information Service (Q327696) 

No No Yes  Yes  

MS02-063 http://www.microsoft.com/technet/
security/bulletin/MS02-063.asp 

Unchecked Buffer in PPTP 
Implementation Could Enable Denial 
of Service Attacks (Q329834) 

No No No Yes  

MS02-065 http://www.microsoft.com/technet/ 
security/bulletin/ MS02-065.asp 

Buffer Overrun in Microsoft Data 
Access Components Could Lead to 
Code Execution (Q329414) 

No No Yes  Yes  

MS02-070 http://www.microsoft.com/technet 
/security/bulletin/ MS02-070.asp 

Flaw in SMB Signing Could Enable 
Group Policy to be Modified 
(309376) 

No No Yes  Yes  
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   Factory-installed on these 
systems: 

This bulletin: Available at: Fixes this problem: 4.0.0 4.2.0 5.0.0 5.2.0 

MS03-008 http://www.microsoft.com/technet/ 
security/bulletin/MS03-008.asp 

Flaw in Windows Script Engine Could 
Allow Code Execution (814078) 

No No No Yes  

MS03-010 http://www.microsoft.com/technet/ 
security/bulletin/MS03-010.asp 

Flaw in RPC Endpoint Mapper Could 
Allow Denial of Service Attacks 
(331953) 

No No No Yes  

MS03-011 http://www.microsoft.com/technet/ 
security/bulletin/MS03-011.asp 

Flaw in Microsoft VM Could Enable 
System Compromise (816093) 

No No No Yes  

MS03-013 http://www.microsoft.com/technet/s
ecurity/bulletin/MS03-013.asp 

Buffer Overrun in Windows Kernel 
Message Handling could Lead to 
Elevated Privileges (811493) 

No No No Yes  

MS03-017 http://www.microsoft.comtechnet/s
ecurity/bulletin/MS03-017.asp 

Flaw in Windows Media Player Skins 
Downloading could allow Code 
Execution (817787) 

No No No Yes  

MS03-023 http://www.microsoft.com/technet/s
ecurity/bulletin/MS03-023.asp 

Buffer Overrun In HTML Converter 
Could Allow Code Execution 
(823559) 

No No No Yes  

MS03-024 http://www.microsoft.com/technet/s
ecurity/bulletin/MS03-024.asp 

Buffer Overrun in Windows Could 
Lead to Data Corruption (817606) 

No No No Yes  

MS03-025 http://www.microsoft.com/technet/s
ecurity/bulletin/MS03-025.asp 

Flaw in Windows Message Handling 
through Utility Manager Could Enable 
Privilege Elevation (822679) 

No No No Yes  

MS03-030 http://www.microsoft.comtechnet/s
ecurity/bulletin/MS03-030.asp 

Unchecked Buffer in DirectX Could 
Enable System Compromise 
(819696) 

No No No Yes  

MS03-033 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS03-033.a sp 

Unchecked Buffer in MDAC Function 
Could Enable System Compromise 
(823718) 

No No No No 

MS03-039 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS03-039.asp 

Buffer Overrun In RPCSS Service 
Could Allow Code Execution 
(824146) 

No No No No 

MS03-041 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS03-041.asp 

Vulnerability in Authenticode 
V erification Could Allow Remote 
Code Execution (823182) 

No No No No 

MS03-042 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS03-042.asp 

Buffer Overflow in Windows 
Troubleshooter ActiveX Control 
Could Allow Code Execution 
(826232) 

No No No No 

MS03-044 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS03-044.asp 

Buffer Overrun in Windows Help and 
Support Center Could Lead to 
System Compromise (825119) 

No No No No 

MS03-045 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS03-045.asp 

Buffer Overrun in the ListBox and in 
the ComboBox Control Could Allow 
Code Execution (824141) 

No No No No 
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   Factory-installed on these 
systems: 

This bulletin: Available at: Fixes this problem: 4.0.0 4.2.0 5.0.0 5.2.0 

MS03-048 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS03-048.asp 

Cumulative Security Update for 
Internet Explorer (824145) 

No No No No 

MS03-049 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS03-049.asp 

Buffer Overrun in the Workstation 
Service Could Allow Code Execution 
(828749) 

No No No No 

 

Note: iPower systems use the multi-language version of Windows 2000 
Professional. When you download language-specific Microsoft patches, 
always use the English-language version even if you run your system in 
another language. 

For up-to-date information about security issues that affect iPower 
products, go to the Polycom Security Center at www.polycom.com.  

Global Management System 

The Global Management System uses the serial number as a unique key to 
identify the system.  When iPower systems are managed by a Global 
Management System, their serial numbers must be properly configured.  

§ Make sure that no two systems are configured to use the same serial 
number. The serial number is printed on the back of the iPower system 
computer unit. Enter the serial number in the Setup Wizard as indicated 
during the installation process.  

§ You must restart the iPower system if you change the serial number (for 
example, if you originally entered an invalid serial number). Otherwise, 
you cannot use the Page System Administrator feature, and the Call 
Status indicator does not display on the Global Management System 
server.  

PathNavigator Call Processing Server 
§ If you make a configuration change on PathNavigator (such as enabling 

Conference on Demand), you must restart the iPower system for the new 
setting to take effect.  

§ The default profile as defined in PathNavigator Conference on Demand 
includes the line rate, the T.120 rate, and video session information. In 
this release, you cannot modify this information. 
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Configuring the iPower system to use PathNavigator 
Conference on Demand 

To configure PathNavigator Conference on Demand, do the following: 

1. Start AdminTools and click  LAN. 

2. Click the Gatekeeper Setup tab. 

3. Check the Use a gatekeeper check box. 

4. In the Gatekeeper DNS name or IP address field, enter the 
PathNavigator gatekeeper DNS name or IP address. 

5. Enter the video call alias and voice call alias in the appropriate fields, and 
click Apply. 

Note that the video call and voice call aliases must be unique. 

6. The Use ISDN to initiate multipoint calls from this system check box 
appears.  

Check this box if you want to enable ISDN Callback. This feature allows 
the system initiating the Conference on Demand call to connect to the 
conference using ISDN. 

7. Click OK. 

8. Configure PathNavigator for Conference on Demand. For details, see the 
PathNavigator documentation. 

Placing a call using PathNavigator Conference on Demand 

To place a call using PathNavigator Conference on Demand, do the 
following: 

1. From the iPower collaboration application, click the Make a Call button 
and then click Directory. 

2. Check the box next to each number that you want to dial.  

The numbers appear in the Selected names field at the bottom of the 
screen. You can select as many numbers as your bridge supports.  

3. Click OK to place the call.  

If you are placing a multipoint call and have enabled ISDN Callback, you 
receive a message from the system indicating that the current call will be 
disconnected. Click OK when you receive this message. The system then 
places calls to all of the designated conference participants (including 
yourself). Answer this call to start the multipoint videoconference. 

If you have not enabled ISDN Callback, the call connects as a regular 
multipoint call, based on the configuration settings. For more information, 
refer to the iPower collaboration application online help.  
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Software Configuration 
§ If the Port Ranges are set incorrectly, the iPower system will crash. For 

information on setting the Port Ranges, start AdminTools and access the 
online help topic  Configuring the Adaptor/NAT/Port Range.  

§ Make sure that iPower is connected to the network before selecting the 
option "Automatically discover the NAT address".  If iPower is 
disconnected from the network, it may experience and internal system 
error. 

§ In this version, systems behind a NAT cannot make multipoint calls using 
the Internal Multipoint feature. 

§ If QoS is enabled, calls through a D-Link NAT (model DI-704P) may not 
work.  

§ If the system is configured with an incorrect NAT address, LAN calls have 
no video.  

§ If you have upgraded to iPower version 5.0 software from a previous 
release, you must install Microsoft's QoS Packet Scheduler in order for 
the iPower system's QoS features to work properly. Note that the QoS 
Packet Scheduler has already been installed on systems pre-installed 
with version 5.0 software.  
To install QoS Packet Scheduler: 

1. Click Start and then choose Settings > Network and Dial-up 
Connections > Local Area Connection. 

2. Click Properties. 

3. Select Internet Protocol (TCP/IP) and click Install. 

4. Select Service and click Install. 

5. Select QoS Packet Scheduler, and click OK. 

§ When you use AdminTools to configure the system for a Maximum 
Bandwidth, the setting does not take effect until the system is restarted.  

§ When you create a WebOffice, your first attempt to log on will be 
unsuccessful. You should be able to log on successfully with subsequent 
attempts.  

§ When an iPower system configured to run on an asymmetric network and 
then is reconfigured not to run on an asymmetric network, the maximum 
incoming bandwidths are changed.  Reconfigure these items to values 
appropriate for your environment.  

§ After you exit the iPower collaboration application, either wait several 
seconds before starting AdminTools (in order to allow the application time 
to complete its shutdown procedure), or launch AdminTools while the 
application is still running. (AdminTools automatically coordinates 
shutdown of the iPower collaboration application.)  
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§ In AdminTools, changes to incoming call bandwidth can cause the iPower 
system to lose its gatekeeper settings.  
To address this issue, do the following: 

1. Start AdminTools and click  LAN. 

2. Click the LAN Bandwidth tab. 

3. Change the incoming call bandwidth, and click Apply. 

4. To force AdminTools to save the change, click the Gatekeeper 
Setup tab, and then click the LAN Bandwidth tab. 

5. Click OK.   

§ Do not enable Internet Connection Sharing in the Windows Network and 
Dial-up Connection settings.  

§ The default audio algorithm for Internal Multipoint calls is G.722. Since 
calls to endpoints that do not support G.722 fail, you must change the 
audio algorithm to G.711 if there are NetMeeting or ProShare® systems on 
the network. Change the audio algorithm for Internal Multipoint calls in 
AdminTools>Internal Multipoint.  

§ You cannot change the community string for SNMP to a blank value. If 
you do, the previous value is restored when you restart the system.  

§ The iPower system registers properly with an ILS server running Windows 
NT, but does not register with an ILS server running Windows 2000.  

§ To disable RAS on an ISDN line previously configured for RAS, first 
uncheck the Use this line for network management via RAS check 
box in the ISDN Bandwidth tab in AdminTools, and then select None.  
If you do not do this first, RAS remains enabled even though the field is 
grayed out. The system may continue to reserve the line for RAS and it 
will not be available for video calls.  

§ When you register the system to a RADVISION gatekeeper, you may 
receive a message that says “Failed to Ping the gatekeeper.” Ignore this 
message.  

§ This release supports the Auto ISDN feature for systems in North 
America. Since not all network equipment supports Auto ISDN, you should 
manually configure your system if Auto ISDN cannot determine the 
network configuration. 

§ If the system is configured to allow users to redial numbers, it retains the 
last number dialed until you log off. If you do not want to save the last 
number dialed, use AdminTools to disable this feature. 

§ You must restart the system after you change the IMUX call mode using 
AdminTools.  

§ Systems configured for V.35/RS-449 do not publish their information to 
the Central Directory. The system administrator must add this information 
manually. 

§ iPower and TeamStation systems use different formats for their local 
directories. You cannot copy a directory file from a TeamStation to an 
iPower system or from an iPower system to a TeamStation. 
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Logging On and Logging Off 
§ You may experience problems if you change the Auto Logon user 

information on a system that is already set up for Auto Logon. To modify 
Auto Logon user information, configure the system to use Standard 
Windows Logon. Then, configure the system to use Auto Logon again. 

§ Make sure you allow the iPower system time to complete its normal 
shutdown procedure. Do not click the End Now button on the Ending 
Application dialog box while the application is still running.  

Audio 
§ The mixer panel for the virtual audio driver on iPower 9000 systems does 

not include a master volume control. You must enable the master volume 
control on the mixer panel. Do the following: 

1. Click the  Speaker icon in the System Tray and select Open 
Volume Controls.  

2. Select Options > Properties. 

3. Select the Playback option. 

4. Check the Volume Control check box. The Master Volume Control 
appears in the mixer panel.  

§ For best results, always use Automatic as the preferred Audio Algorithm.  

Video 
§ Avoid changing laptop screen resolution while it is the active Content 

source. 

§ For best results, always use Automatic as the preferred Video Algorithm.  

§ When you change the video display resolution, shut down the iPower 
collaboration application, change the resolution setting, and then restart 
the iPower system.  

§ The supported resolutions for main display of the iPower system are 
800x600 and 1024x768 pixels. 

§ To use the 32-inch XGA monitor at 1024x768 pixels, set the display to 60 
Hz. 

§ When using a laptop or PC as a Content source, the following modes 
display valid video if the laptop or PC conforms to VESA standards: 

640x480, 60 Hz 800x600, 56 Hz 800x600, 75 Hz 
640x480, 72 Hz 800x600, 60 Hz 1024x768, 60 Hz 
640x480, 75 Hz 800x600, 72 Hz 1024x768, 75 Hz 

If the setting does not conform to VESA standards, the image may not 
display. Note that some unsupported modes may display on the laptop 
thumbnail if they approximate a supported VESA standard.  
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VCR 
§ When you record a meeting: 

– All audio is recorded. 

– On systems using a single monitor, everything on the monitor is 
recorded (both People and Content). 

– On systems using dual monitors, if a Content source is being shown, 
it is recorded. If no Content is being shown, far-end video is 
recorded. 

§ The system may not display VCR video while fast-forwarding a tape.  

§ Some VCRs may not appear on the People and Content list unless they 
are playing a tape. You can use AdminTools to configure the system to 
include the VCR on the People and Content list, even if no signal is 
detected. 

Calling 
§ When the iPower system is showing Content in a non-Dual Images call, 

the iPower system cannot adjust its People camera. The iPower system 
can only control a camera that is displaying video.  

§ In this software version, you cannot make 2x64 non-dialed (DCE-signaled 
or DCE-dedicated) calls.  To address this issue, place 1x128 calls 
instead. 

§ In a multipoint call that includes the ViewStation FX, the iPower system 
cannot control the presenter’s camera  

§ During a call, you may experience substantial delays in T.120 activities 
when the far end takes control. 

§ To make a loopback call, select a rate less than or equal to the number 
of ISDN lines connected.  

§ When you are in a loopback call, the system does not allow you to select 
the Content source. 

§ Conference Statistics and Operating Statistics may report a video error 
when you add or remove Content from a videoconference. This does not 
affect the quality of the call.  

§ The iPower system does not transmit video in an H.263 ISDN QCIF call to 
a PictureTel Concorde•4500. To address this issue, set the resolution on 
the Concorde to CIF.  

§ If an iPower system receives a still-image graphic from another type of 
system, the iPower system displays the graphic until the end of the call.  

§ If an iPower system receives a still-image graphic from another type of 
system and you switch the image from the main video window to the PIP, 
the PIP displays a black screen.  

§ Use a voice alias or E.164 address when placing Voice over IP (VoIP) 
calls. Encourage callers to do the same. Otherwise, the system may treat 
an incoming or outgoing call as a video call (for example, it may 
automatically answer the call if you configured auto-answer for video 
calls).  
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§ If a call is sent through a gateway or MCU that does not support People 
and Content, the Content video quality is reduced, even if both 
endpoints support People and Content.  

§ Configure a gatekeeper before attempting to make gateway calls.  

§ In a PathNavigator Conference on Demand call, only the local system is 
included in the Conference Sites list. To include all sites, enable Chair 
Control on the MCU.  

§ Conferences hosted by an Avaya MCU do not support the Browse 
function.If you select Remote Control > Far-End Camera and turn off 
Picture-in-Picture (PIP) from the iPower collaboration application Options 
menu, you are unable to switch to near-end camera control.  

§ When using an Ezenia! H.323 MCU, the call does not connect when dialed 
with an E.164 address that starts with the digit “1”.  

§ When you use the on-screen Camera Controls, you cannot use the on-
screen cursor for functions outside of the Camera Controls, such as 
muting. You can use the buttons on the remote control or a keyboard 
shortcut.  

§ A call must be at least 112 kbps to send Content. The system does not 
send Content in a 56 kbps or 64 kbps call.  

§ If you attach V.35/RS-449 cables to the system when it is powered on, 
the system may interpret any signal changes as an incoming call. To 
address this issue, power off the system before connecting the cables.  

§ In a V.35 DCE-Signal call to a Concorde•4500 system, the iPower system 
may hang up the call and not reconnect. To address this issue, configure 
the iPower system for DCE-Dedicated calls when placing or receiving 
non- dialed calls from a Concorde system.  

§ In V.35 DCE-Signal calls, a Montage system does not disconnect properly 
from the iPower system. To address this issue, configure the iPower 
system for DCE-Dedicated calls.   

§ Use the following encryption type settings with the call modes listed 
below. All other settings are invalid:  

Encryption Type  Call Mode 

KG-194 DCE-Signal 
DCE-Dedicated 

KIV-7 Dialed 

None Dialed  
DCE-Signal 
DCE-Dedicated 

 

§ If you are using encryption in a DCE-Dedicated call, the call may take up 
to one minute to completely disconnect from the system.  

§ iPower does not support these types of 2x64 calls:  
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– 2x64 calls where both channels are dialed simultaneously 

– Non-dialed (DCE-signaled or DCE-dedicated) 2x64 calls 

§ Dialed V.35/RS-449 2x64 calls may take up to 20 seconds to receive 
remote video.  

§ On 900 or 9000 systems (V.35 or RS-449) using a Lucent/Ascend IMUX in 
Dialed mode, the IMUX may sometimes get into a state where it cannot 
place or receive 2x64 kbps or 2x56 kbps calls. If this occurs, access the 
IMUX through its console and force it to disconnect its second port. For 
information on how to do this, refer to the IMUX documentation.  

§ Note the following when using a PT-235 adapter: 
– A V.35/RS-449 system operating with a PT-235 adapter that is 

configured for KIV-7 compatibility may experience delays or problems 
when disconnecting from a call. Configure the PT-235 adapter to 
hang up the call if it loses synchronization for a specified time period. 
Refer to the PT-235 documentation for information.  

– The iPower system does not support restricted call rates when using 
a PT-235 adapter.  

– The iPower system does not support constant-carrier V.35/RS-449 
(DCE-Dedicated) calls to Montage when using a PT-235 adapter.  

– The iPower system does not support connecting a Quad-BRI to both 
a PT-235 adapter and a network/PBX ISDN line. For this reason, you 
cannot use the fourth ISDN BRI line when the system is connected to 
a PT-235 adapter.  

– If you are placing a call through a PT-235 adapter, perform the 
following steps to ensure that the call profile matches the call profile 
in the IMUX.  

1. From the iPower collaboration application, click Make a Call. 

2. Enter the appropriate setting for your IMUX type: 

IMUX  Setting Example 

Promptus #Call Profile**Video 
Number 

#60**95551731  

(384 kbps call with a 
call profile of 60) 

Lucent #Call Profile Video Number #01095556789 

(384 kbps call with a 
call profile of 010) 

 

3. If you need to select the call rate, click Advanced. 

§ The iPower system is pre-configured with IMUX call modes that are used 
to dial common rates with the Lucent Multiband IMUX or the DICA Oasis 
IMUX. If you request a rate that is not configured, the system dials the 
next lowest rate. To dial at a rate that is not pre-configured, you can 
either provide the information when you dial the call, or set the IMUX 
type to Other in AdminTools, then configure the rates to support.  

§ When you use iPower Control Protocol to make calls from a LAN system 
to an ISDN system:  
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– All prefixes and suffixes required by the gateway must be configured 
through AdminTools 

– The iCP Command must set the Calltype to Gateway. 

Internal Multipoint Option 
§ In this version, systems behind a NAT cannot make multipoint calls using 

the Internal Multipoint feature. 

§ The Internal Multipoint option uses several features that most gateways 
do not implement, such as flow control. As a result, Internal Multipoint 
calls through a gateway may fail to connect or may experience various 
problems, such as black video. 

Note: Internal Multipoint calls through gateways do not support 
Continuous Presence. 

§ All participants in an Internal Multipoint conference must support G.722. 
If any do not, you must change this algorithm to G.711 using AdminTools. 
Do the following:   

1. Start AdminTools and click  Internal Multipoint. 

2. In the Audio Algorithm field, select G.711. 

§ You must restart the system after you activate the 12-site Internal 
Multipoint option.  

§ You cannot make an Internal Multipoint call using ISDN. If you try to do 
so, you receive an error message. To place an ISDN call, make sure the 
Allow additional video sites check box is unchecked.  

§ When a site that does not support People and Content joins or leaves a 
call, other sites that support People and Content may briefly receive 
black video while People and Content is being enabled or disabled. 

§ The Polycom ViewStation briefly displays distorted video when an iPower 
system leaves a videoconference. 

Using a RADVISION Gatekeeper on an iPower System with 
Internal Multipoint 

In order to use a RADVISION gatekeeper on an iPower system with Internal 
Multipoint, you must register the iPower system with the gatekeeper. Do 
the following: 

1. Use AdminTools to register the iPower system with the gatekeeper. 

2. On the gatekeeper, use the following configuration tools to locate the 
entry for the iPower system:  

o Use OnLAN on the L2W-323. 

o Use the web browser on the ECS to access the administrator 
page. 
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3. On the gatekeeper, specify that the iPower system is Predefined, and 
save your change. 

4. Add a predefined endpoint on the gatekeeper with the following 
properties: 

Set this property: To this value: 

Type MCU 

Registration IP IP address of the iPower system 

Forward to Leave blank 

Port 1701 

Type Use the default setting 

Alias Conference@name of the iPower system 

Alias Type Name 

Allowed Services All services allowed 

Note: After registering the system with the gatekeeper, wait several 
minutes before making calls with the iPower system.  

WebRemote 
§ You cannot use WebRemote to place an Internal Multipoint call. 

§ When you use AdminTools to disable WebRemote and then re-enable 
WebRemote, you must restart the system before you can use 
WebRemote.  

§ After making changes to the Network Management settings, you must 
either restart the iPower system or uncheck and check the Allow 
management via SNMP check box to force the system to save the 
changes immediately.   

§ To display WebRemote statistics charts, configure SNMP with a 
community string of public.   

§ If you are using WebRemote, you will not see any changes made to the 
system configuration using AdminTools during your WebRemote session. 
You must exit and restart WebRemote to see the changes.   

§ If you use WebRemote on a Chinese or Japanese system, and you select 
a language other than Chinese, Japanese, or English, some WebRemote 
pages (such as those with accented characters) may not display 
properly.  

§ Use Internet Explorer 5.0 (or higher) or Netscape® Navigator 4.06 (or 
higher) when using WebRemote. 

§ To view the Alarms and Statistics pages, you must configure your web 
browser to use Microsoft Java runtime. Perform the following steps:  

1. From the web browser, select Tools > Internet Options and click 
Advanced. 

2. Uncheck the check boxes for any other Java plug-ins.   
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Note: Netscape Navigator 6.0 does not display the Alarms and Statistics 
pages.  

§ You cannot save system configuration changes made using WebRemote if 
Auto Logon is enabled and the Auto Logon password is blank. You must 
change the Auto Logon name and enter a password. 

Hardware 

The iPower system is tested extensively with the hardware configuration 
supplied as standard with this system. Polycom cannot warrant the 
operation of the system if you replace or add your own hardware. Unless a 
separate maintenance contract is in place, our technical support personnel 
may request that you replace the original hardware to be able to effectively 
isolate any problem. Please note that the software supplied to install the 
operating system and the iPower collaboration software will not reflect any 
user-installed hardware. 

§ When you power on an iPower 9000 system with an iPower 70 camera, 
the camera may take a few minutes to fully initialize. During this time, 
you may see a camera readiness message. You do not need to take any 
action. After the start-up period, the message disappears and the 
system is ready to use. 

§ The DVD drive in the iPower 9000 system reads CDs and data DVDs, but 
it does not play video DVDs. If you try to install the software required to 
play video DVDs, it may conflict with the iPower system’s video drivers. 
To address this issue, connect an external DVD player to the iPower 9000 
system just as you would connect a VCR.   

§ On the iPower 9000 system, the VGA monitor connector labeled Monitor 3 
(the second VGA output) is not supported.   

§ When using a Hitachi™ CMP307XU or other native XGA display device, 
change the resolution of the iPower system to 1024x768 for better 
display quality.  

§ If you are using any USB device, you must obtain and install the latest 
Windows 2000 drivers from the manufacturer’s web site. 

§ If you ordered the iPower system with PN 370-1214-02 V.35/RS-449 
board, make sure that you use the correct jumper settings and the 
appropriate cable.  
– This board supports both V.35 and RS-449, depending on how you 

set the J3 jumper.  

If you use: Set jumper J3 to: Use this cable: 

V.35 Pins 2 and 3 180-0339-01 

RS-449 Pins 1 and 2 180-0340-02 
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– This board also ships with support for the KG-194 encryption device 
enabled. To enable support for the KIV-7 encryption device, set the 
J2 jumper setting as shown in the table below.  

If you use: Set jumper J2 to: 

KG-194 encryption Pins 1 and 2 

KIV-7 encryption Pins 2 and 3 

§ The new iPower 9000 remote control and keyboard use infrared (IR) 
signals that operate at a frequency of 38.4 kHz and a wavelength of 
940 nm. The iPower 600/900 remote control uses IR signals that operate 
at a frequency of 38 kHz, 880 nm. The older iPower 600/900 keyboard 
and trackball use IR signals that operate at 56 kHz, 950 nm.  
On rare occasions, room lighting may interfere with these signals, which 
could reduce the range of the devices or render them inoperable. If you 
encounter this situation, do one or more of the following: 

– Decrease the room lighting. 

– Change lighting and ballasts to a frequency outside of the range used 
for the Polycom devices. 

– Use a hard-wired or radio-frequency (RF) keyboard. 

iPower Applications 
§ The following objects in the iPower SNMP MIB do not implement the Write 

operation, even though the MIB specifies them as Read-Write: 
– ptConfSysDescription 

– ptConfSysNotificationMode 

– ptConfSysName  

– ptConfSYSOID  

– ptConfSysUpTime 

– Objects in the Advanced Configuration 

Write operations against these objects appear to complete 
successfully but do not actually change anything. 

In addition, the MIB-II object ptConfSysName does not implement the 
Write operation. Write operations against it appear to complete 
successfully but do not actually change anything. 

§ After you restart the system, you may see an error message the first 
time you access the iPower collaboration application online help. Click Yes 
to continue.  

§ You must restart the iPower system after running the Hardware 
Diagnostics application. 

Third-Party Applications 

The iPower system is tested extensively with third-party software. Polycom 
attempts to address compatibility issues with all third-party applications for 
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which the operating system, CPU, and memory are appropriate. However, 
incompatibilities may arise due to the complex nature of a multimedia 
collaboration system. In the event that an incompatibility issue arises, 
Polycom technical support may request that you uninstall a third-party 
application in order to isolate the problem.  

The following applications are pre-installed on the iPower system:   

§ Microsoft Internet Explorer (IE) Version 6.0 with Service Pack 1 

§ Microsoft Word Viewer 97 

§ Microsoft Excel Viewer 97 Version 8.0 

§ Microsoft PowerPoint Viewer 97 Version 8.0 

§ Microsoft NetMeeting Version 3.01 

§ Adobe Acrobat Reader Version 5.0 

Version 5.0.0 of the iPower system has been tested and found compatible 
with the following third-party applications.  

§ Microsoft Office XP 

§ McAfee VirusScan Version 4.5.1 

§ PCAnywhere Version 10 (configured for Legacy video mode) 

§ WinZip Version 8 

§ Adobe Acrobat Version 5.0 

Note: This list is not a complete inventory of compatible applications; it 
simply indicates the applications that have been tested for 
compatibility with this release. 

Be aware of the following application-related restrictions in this release: 

§ Do not use Windows Update to update the drivers for the Savage video 
chipset. Polycom provides a customized video driver. Replacing the 
Polycom video driver may cause problems with iPower system video.   

§ If you use NetMeeting Chat to send a message in a T.120 call, the 
NetMeeting Chat window does not pop up on the system receiving the 
message. You must maximize the window manually.  

§ You must close the iPower collaboration application when running 
applications that utilize DirectDraw resources (for example, certain 
screen savers and video applications such as streaming viewers). 

§ iPower 900 systems running Windows Media Player version 9.0B may 
experience system crashes when playing .AVI files. If this happens, follow 
these steps: 

1. From Windows Media Player, choose Tools > Options and 
then click the Performance tab. 

2. Move the Video Acceleration slider to the None position.  
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Localization 

The translation for the [Near/Far] button on the Japanese-language 
versions of the iPower 9000 remote control and keyboard is inaccurate. The 

translation should read , instead of . This will be 
corrected in future versions of the remote control and keyboard. 

For information about the availability of the Japanese-language versions of 
the iPower 9000 remote control and keyboard, contact your Polycom 
service provider. For information about using the Near/Far button, see the 
iPower System help. 

 

Data Collaboration 
§ When sharing applications in an iPower conference, annotations from the 

SMART Board™ interactive whiteboard can be written from both sites. 
From the remote site, these annotations can take several seconds to 
update back to the host site. This differential depends on the speed of 
your data connection. To address this issue, SMART Technologies Inc. 
implemented a Remote Local Update feature in the SMART Board driver. 
Remote Local Update allows remote sites to annotate and see the 
annotations instantly on their boards. Although these annotations are 
seen instantly at the remote sites, it actually takes them a few seconds 
to appear at the host site. The benefit of this feature is that the 
remote-site annotations appear to be updated instantly.  

§ Calls placed with an Avaya, PictureTel Montage, or Ezenia! H.320 MCU do 
not support T.120.  

Note: T.120 works reliably in calls with a Polycom H.320 MCU, Version 
3.00 or higher.  

§ T.120 is not supported in ISDN multipoint calls using PathNavigator 
Conference on Demand.  

§ Data sharing is not available for calls made through a gateway to a 
PictureTel 330 MCU.  
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§ T.120 may not function properly in calls made through a gateway from a 
LAN system to an ISDN system.  

§ Application sharing is significantly slower in ISDN calls than in LAN calls. If 
you do not need to allow the far-end to modify your document, you can 
address this issue by sharing your document as video using the 
ImageShare device, or by sharing the iPower system Windows Desktop.  

§ An iPower system running software lower than Version 3.0 (or any other 
system that uses NetMeeting Version 2.11 as its data collaboration 
engine) cannot collaborate on applications that are shared by an iPower 
system running Version 3.0 software or higher. 

§ When a far-end site stops sharing an application via T.120, the sharing 
window may remain on the screen and hide the far-end window. To 
address this issue, minimize the application-sharing window to bring the 
iPower collaboration application and video to the foreground.  

§ Sharing an Adobe® Acrobat® file may cause the system to freeze if the 
far end tries to take control. To address this issue, hang up the call and 
redial.  

§ To ensure that all participants see the same region of a shared 
application, set up all systems with the same resolution whenever 
possible.  

§ If you change the system’s configuration to allow T.120 calling, you must 
reboot the system before the change takes affect before you can make 
calls to a ViewStation or ViewStation FX.  

Additional Information 
If you need further assistance with your system, you can refer to these 
resources: 

§ For help with ordering ISDN or with setting up your LAN for collaboration, 
see Preparing Your Network for Collaboration, available on the iPower 
Documentation CD or from the Polycom web site at www.polycom.com. 

§ For help with administrator tasks, see the AdminTools online help or refer 
to the iPower Collaboration System Tips and Troubleshooting Guide, 
available on the iPower Documentation CD or from the Polycom web site 
at www.polycom.com. 

§ For the latest information and updates, use your web browser to go to  
www.polycom.com. 

§ When sending error log files to Polycom, compress them with the WinZip 
application. To download the most current evaluation copy of this 
software, go to www.winzip.com. You may also order a full copy of 
WinZip at this site. 
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Installing Version 5.0 Software on the iPower 
Systems 

This section describes how to upgrade or reinstall the 5.0.0 software on the 
iPower 600, 900, and 9000 systems. 

After upgrading or installing 5.0.0 software, Polycom recommends that you 
go to www.polycom.com for any 5.x maintenance updates. 

Installing Version 5.0 Software on the iPower 600 
System 

For iPower Release 5.0, you can upgrade the iPower 600 system software 
by downloading iPower_5_0_0_Update.exe from the Polycom Web site 
(www.polycom.com). 

You can apply iPower Version 5.0 software to your system only if it is 
running software Version 4.x. If your system is running an earlier version, 
upgrade it to 4.x before you begin. 

Before You Upgrade the iPower Software 

Before you upgrade the iPower software to Version 5.0, make sure you do 
the following: 

1. Log on to the system as the Administrator. 

Log into the local account Administrator. If you select another 
account, you may experience installation problems, even if the 
account has administrative rights. 

If your system is set up for Auto Logon, use AdminTools to configure 
the system to use Standard Windows® Logon, and restart the 
system. See the iPower Collaboration System Tips and 
Troubleshooting Guide for details. 

2. Download the software from the Polycom Web site 
(www.polycom.com) to your local drive. On an iPower 600 system, 
you must download the software to the D: drive. 

Note: If your iPower 600 system has access to a USB CD-ROM drive 
or a network CD-ROM drive, you can choose to upgrade using 
a CD (part number 5151-50789-001/A).   

3. Ensure that you have at least 195 MB of free space on both the C: 
and D: drives.  

To free up space on these drives, consider the following measures: 

– Delete Temporary Internet Files:  
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o To display these files, from Windows Explorer, choose 
Tools>Folder Options. Click the View tab and select Show 
Hidden Files and Folders.  

o To delete these files, start Internet Explorer and select 
Tools>Internet Options. In the Temporary Internet Files 
section, click Delete Files. You can delete these files for each 
system user. The files are stored in C:\Documents and 
Settings\<username>\Local Settings\Temporary Internet Files. 

– Delete files in the C:\Documents and Settings\ <username>\Local 
Settings\Temp directories. 

– If you have installed any Win2K service packs, do the following: 

o From Windows Explorer, choose Tools>Folder Options. Click 
the View tab and select Show Hidden Files and Folders.  

o Delete or move to the D: drive any folders under C:\WINNT 
that have a name starting with $NtUninstall followed by 
several additional characters. This could free up 7 to 8 MB. 

– Delete any large .dmp files from C:\Documents and Settings\All 
Users\Documents\DrWatson\. 

– Reduce the size of the paging file on the C: drive. To do this: 

o From the Windows Desktop, right-click My Computer, then 
click Properties. 

o Click the Advanced tab. 

o Click Performance Options. 

o Click Change…  

o For the C: drive, set the initial and maximum size to 8 MB. 

o Click OK until the computer reboots. 

– If any of these files are large, you can delete them to free significant 
space: 

o C:\iPower_install.txt  

o C:\iPower_install.log 

o C:\sapi_install_log.txt  

o C:\DpProcessor0.txt, C:\DpProcessor1.txt, 
C:\DpProcessor2.txt, C:\DpProcessor3.txt  

o “C:\winnt\Windows Update Setup Files” and all files and 
subfolders 

– Empty the Recycle Bin. 

4. Close all Windows applications, including any anti-virus software. 

Upgrading the iPower 600 System Software 

This section contains information about upgrading your iPower 600 system 
software to Version 5.0. 
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1. Double-click iPower_5_0_0_Update.exe to start the upgrade, and 
then follow the instructions on the screen. 

2. When the Digital Signature Not Found dialog box appears, click Yes 
to continue.  

3. When the second Digital Signature Not Found dialog box appears, 
click Yes again. 

4. Restart the system to complete the upgrade. 

5. Polycom recommends that you go to www.polycom.com to check for 
any 5.x maintenance updates. 

Installing Version 5.0 Software on the iPower 900 or 
iPower 9000 System 

For iPower Release 5.0, you can upgrade or reinstall the iPower 900 or 9000 
system software in one of these ways: 

§ To upgrade, do one of the following: 
– Use the CD-ROM with part number 5151-50789-001/A (model number 

2200-51030-001). 

– Download iPower_5_0_0_Update.exe from the Polycom Web site 
(www.polycom.com). 

Note: You can upgrade to iPower Version 5.0 software only if your 
system is running software Version 4.x. If your system is running 
version 3.x, you must first upgrade to version 4.x  and then 
upgrade to 5.0. If you have version 2.x or earlier (which uses 
Windows NT as its operating system), you must reinstall the iPower 
software since Version 5.0 uses Windows 2000 as its operating 
system. See the section “Reinstalling the iPower 900 or 9000 
System Software” for more information. 

§ To reinstall the iPower 900 system software, use the boot floppy and the 
two-CD set with part numbers 5151-50783-001/A and 5151-50784-001/A 
(model number 2200-51032-001). 

§ To reinstall the iPower 9000 system software, use the two-CD set with 
part numbers 5151-50356-001/A and 5151-50357-001/A (model number 
2200-51033-001). 

Before You Upgrade the iPower Software 

Before you upgrade the iPower software to Version 5.0, make sure you do 
the following: 

1. Log on to the system as the Administrator. 

Log into the local account Administrator. If you select another 
account, you may experience installation problems, even if the 
account has administrative rights. 

If your system is set up for Auto Logon, use AdminTools to configure 
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the system to use Standard Windows Logon, and restart the system. 
See the iPower Collaboration System Tips and Troubleshooting Guide 
for details. 

2. If you are obtaining the software from the Polycom Web site 
(www.polycom.com), download the software to your local drive. 

3. Ensure that you have at least 195 MB of free space on the C: drive.  

4. Close all Windows applications, including any anti-virus software. 

Upgrading the iPower 900 or 9000 System Software 

This section contains information about upgrading your iPower 9000 or 900 
system software to Version 5.0. 

To upgrade iPower 900 or 9000 system software 

1. If you are upgrading from a CD, insert the CD into the CD-ROM drive.  

2. Double-click iPower_5_0_0_Update.exe to start the upgrade, and 
then follow the instructions on the screen. 

3. When the Digital Signature Not Found dialog box appears, click Yes 
to continue.  

4. For iPower 900 systems, a second Digital Signature Not Found dialog 
box appears. When it does, click Yes again. 

5. Restart the system to complete the upgrade. 

Reinstalling the iPower 900 or 9000 System Software 

When you reinstall the iPower Version 5.0 system software, all of your 
system settings, Directory entries, and other user files are overwritten. 

1. Back up local directory data. 

Save your Local Directory data by copying  
C:\Program Files\PictureTel\vcs\tsdir.ini to external media. 

2. Record configuration settings. 

Make a record of your configuration settings by running the Polycom 
Operating Statistics utility. On the Configuration Summary page, click 
Save As to save the iPowerSysConfigLog.txt file to external media. 
You can use this information to help reconfigure the system after the 
upgrade. 

3. Make sure you have the iPower 9000 or 900 system serial number and 
your LAN and ISDN settings. 

4. For iPower 900 systems only, insert the boot diskette for the Version 
5.0 upgrade into the diskette drive. 

5. Insert the CD marked Disk 1 of 2 into the CD-ROM drive, and then 
power on the system.  
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A warning screen appears. Press Enter to continue. 

6. Insert the CD marked Disk 2 of 2 when you see this dialog box:  

 

Press Enter after you insert the second CD. 

7. Follow the instructions on the screen, and restart the system to 
complete the upgrade.  

If the system does not restart automatically after completing the 
upgrade, you must restart it manually.  

During installation, a “0x0B Read Default” error message may appear, 
along with Abort and Retry buttons. Since the mouse is inactive at 
this point, press Enter to continue the installation process.  

8. After installing 5.0.0 software, check www.polycom.com for any 5.0.x 
maintenance updates. 

Installing the Driver for the V.35/RS-449 Board 

If you reinstall iPower software and your system has a V.35 board  installed, 
you may notice that Disable ISDN or IMUX calls on this system is selected 
and grayed out. To address this issue, exit the Setup Wizard and install the 
driver for the V.35/RS-449 board. To do this, perform the following steps: 

1. From the Windows Desktop, right-click My Computer, then click 
Properties and select the Hardware tab. 

2. Click Device Manager. In the list, select System Devices, then 
double-click PictureTel PCI DDM Card. 

3. Select the Driver tab, click Update Driver, and then click Next. 

4. Select Search for a suitable driver for my device 
(recommended) and click Next. 

5. Select Specify a Location and click Next. 

6. In the Copy manufacturer’s files from drop-down list, enter 
C:\WINNT\inf, click OK, and click Next. 

7. The message “The wizard found a driver for this device” appears. 
Click Next. 

8. The Insert Disk popup box appears. Click OK. 

9. When the Files Needed screen appears, click Browse. Specify the 
path C:\winnt\system32\drivers. 

10. Click OK and then click Finish to complete driver installation. 
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11. Reboot and rerun the Setup Wizard. 

Installing Maintenance Update 5.3.0 on the iPower 
Systems 

To install 5.3.0 on a system running software version 5.x, follow the steps 
given below. If your system is running version 4.x or earlier software, you 
must first upgrade to 5.0.0.  

1. To verify that you are running version 5.0.0 FCS, 5.1.0 or 5.2.0 
software, click Options and choose Properties > About. Click Info. 
The software version should be 5.0.0.415, 5.1.0.724 or 5.2.0.828. 

2. Log on to the system using an account with administrative privileges.  

• If your system is set up for Auto Logon, use AdminTools to 
configure the system to use Standard Windows Logon, and restart 
the system. See the AdminTools online help for details.  

3. Go to www.polycom.com and download 
iPower_5_3_0_FastUpdate.exe to the local hard drive.  

4. Close all Windows applications, particularly any anti-virus software.  

5. Double-click on iPower_5_3_0_FastUpdate.exe to start the update.  

6. Follow the instructions on the screen, and restart the system to 
complete the update. The version given in the About box should be 
5.3.0.1202. 

Note: After upgrading an iPower 9000 system to 5.3.0 from 5.1.0 or 
earlier software, you are prompted to reboot the system again. Be 
sure to perform the requested reboot.  You will need to do this for 
locally-applied updates as well as for updates performed via 
WebRemote or the Global Management Server. 

This “extra” reboot occursthe first time a system updates from 
5.1.0 or earlier software to 5.2.0 or later software; it will not be 
required for future updates. 


